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Preface

Welcome to Oracle Developer! This document will help you get started with Oracle 
Developer Release 6.0 for Windows NT or Windows 95.

Structure
Chapter Contents

Chapter 1 Installing Oracle Developer and using the Oracle Client Soft-
ware Manager.

Chapter 2 For System Administrators: Steps for setting up and maintain-
ing database tables.

Chapter 3 Overview of the Oracle Developer components:

■ Project Builder

■ Form Builder

■ Graphics Builder

■ Report Builder

■ Procedure Builder

■ Query Builder

■ Schema Builder

■ Translation Builder

Appendix A Instructions on configuring your system in order to create 
reports that use Oracle Express data.



Prerequisites
You should be familiar with your computer and its operating system. For example, 
you should know the commands for deleting and copying files and understand the 
concepts of search paths, subdirectories, and path names. Refer to your Microsoft 
Windows 95 or NT and DOS product documentation for more information.

You should also understand the fundamentals of Microsoft Windows, such as the 
elements of an application window. You should also be familiar with such pro-
grams as the Explorer, Taskbar or Task Manager, and Registry.

Notational Conventions
The following typographical conventions are used in this guide:

Related Publications
You may also wish to consult the following Oracle documentation:

Convention Meaning

fixed-width font Text in a fixed-width font indicates commands that you enter 
exactly as shown. Text typed on a PC is not case-sensitive unless 
otherwise noted.

In commands, punctuation other than brackets and vertical bars 
must be entered exactly as shown.

lowercase Lowercase characters in a command statement represent a vari-
able. Substitute an appropriate value.

UPPERCASE Uppercase characters within the text represent command names, 
SQL reserved words, and keywords.

boldface Boldface is used to indicate user interface items such as menu 
choices and buttons.

C> C> represents the DOS prompt. Your prompt may differ.

Title Part Number

Oracle Developer: Guidelines for Building Applications A58766

SQL*Plus User’s Guide and Reference Version 3.1 A24801
x
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Installing Oracle Deve
1

Installing Oracle Developer

This chapter explains how to install Oracle Developer for Windows NT and 
Windows 95 and provides the following information to help you get started:

■ System Requirements

■ Installing Oracle Developer

■ Using OCSM for a Multiple-Client Installation

■ Upgrading from a Previous Release

■ Removing Oracle Products

1.1 System Requirements
This section lists the recommended system requirements for Oracle Developer for 
Windows 95 or NT. The specifications below represent a configuration that should 
work well for most application development projects. You may find that your 
project works well with even fewer resources.

■ An IBM or 100% compatible PC with an 80486/Pentium 33 MHZ processor or 
better.

■ A CD-ROM drive functioning as a logical drive (for installation only).

■ 8 MB RAM for one Runtime component and 3 MB for each additional Runtime 
component you want to run concurrently.

■ 16 MB RAM for one Builder component and an additional 4 MB for each 
additional Builder you want to run concurrently.

■ The Oracle Installer provides hard disk space requirements for each product in 
the Space Required field.
loper 1-1



System Requirements
■ For 32-bit applications, either Microsoft Windows 95 or Microsoft Windows NT 
4.0.

■ A remote Oracle7 or Oracle8 database server and SQL*Net for Windows, 
Personal Oracle for Windows, or Personal Oracle Lite.

■ (Optional) SQL*Plus for Windows, Version 3.1.1.9.3 or later, or SQL*DBA for 
Windows, Version 6.0.33.0.5 or later. (SQL*Plus is included with Oracle 
Developer. SQL*DBA is available separately.) SQL*Plus or SQL*DBA is 
necessary only for users who want to store Oracle Developer modules in 
database tables.

For information on monitor, printer, and mouse requirements, see your Microsoft 
Windows 95 or NT documentation. 

NOTE: Before installing any other Oracle Developer products, it is 
strongly recommended that you read the Oracle Developer Release 
6.0 Release Notes for the most current product information. Once 
they have been installed, they can be found in the file 
relnotes.txt in %ORACLE_HOME%\TOOLS\DOC60. To read this 
file, perform the following steps. See Section 1.2 for more 
information on using the Oracle Installer.

1. Start the Oracle Installer.

2. In the Installation Options dialog box, choose Custom 
Installation or Removal.

3. From the list of available products, select Oracle Developer 
Release Notes.

4. Choose Install.

5. When installation is complete, exit the Oracle Installer.

You can access the release notes by choosing Start→Oracle 
Developer R6.0→Release Notes. Once you have read the release 
notes and are ready to begin installing Oracle Developer, you can 
follow the instructions in Section 1.2.1 to start the Oracle Installer 
again and return to the Oracle Developer Installation Options 
dialog box.
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Installing Oracle Developer
1.2 Installing Oracle Developer
You can install Oracle Developer on either a single client machine using the Oracle 
Installer, or on several client machines using the Oracle Installer and Oracle Client 
Software Manager (OCSM).1

To install Oracle Developer, perform the following steps, each of which is described 
in detail in the rest of this chapter.

1. Start the Oracle Installer. (See Section 1.2.1.)

2. For a single-client installation:

Install Oracle Developer. (See Section 1.2.2.)

For a multiple-client installation:

a. Set up OCSM host machine.  (See Section 1.3.1.)

* Install Oracle Client Configuration Manager, Oracle Client Software 
Agent, and Oracle Installer.

* Grant clients access to OCSM host machine.

* Install products for distribution on OCSM host machine.

b. Register clients with OCSM host machine. (See Section 1.3.2.)

c. Configure clients using OCCM on host machine. (See Section 1.3.3.)

d. Install products on client machines using OCSA. (See Section 1.3.4.)

3. Build the Oracle Developer database tables. (See Section 1.2.3.)

4. Configure the Oracle Developer Server (required only if you intend to deploy 
your applications on the Web). (See Section 1.2.4.)

CAUTION: If you are upgrading from a previous release, be sure to read 
Section 1.4, "Upgrading from a Previous Release" for pre-installation considerations.

1.2.1 Step 1: Starting the Oracle Installer
The Oracle Installer for Windows 95 and for NT 4.0 has an autorun feature which 
executes setup.exe executes and launches the Oracle Installer when you insert 
the CD-ROM. To disable the autorun feature, hold down the shift key while 

1 Oracle Developer is compliant with Oracle Client Software Manager (OCSM) and Oracle Software 
Manager (OSM). This chapter provides instructions for using OCSM; for more information on OSM, 
see the OSM documentation.
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Installing Oracle Developer
inserting the CD and perform the following steps to start the Oracle Installer. (Note 
that not all CD-ROM drives support the autorun feature.)

To start the Oracle Installer:

1. Shut down any active Windows applications.

2. Choose Start→Run to display the Run dialog.

3. In the Run dialog box, type the following (where D: is your CD-ROM drive 
letter):

D:\SETUP.EXE

4. Click OK to start the Oracle Installer.

Before the installation begins, two dialog boxes are displayed:

■ In the Language dialog box, select the language in which you wish to run 
Oracle Developer.

■ In the Oracle Installation Settings dialog box, enter your company name and the 
path for the ORACLE_HOME directory. It is recommended that you keep the 
default setting.
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Installing Oracle Developer
1.2.2 Step 2: Installing Oracle Developer
The Oracle Installer offers three types of installation:

Figure 1–1 Oracle Developer Installation Options dialog box

To install Oracle Developer:

For a single-client installation:

In the Installation Options dialog box, choose the type of installation you want 

Installation Type Description

Development Installation This option automatically installs a subset of the Oracle 
Developer components that would be most commonly used in 
a development environment. To list the components that are 
installed with these installation options, click the Help button 
in the Oracle Developer Installation Options dialog box.

Deployment Installation This option automatically installs a subset of the Oracle 
Developer components that would be most commonly used in 
a deployment environment. To list the components that are 
installed with these installation options, click the Help button 
in the Oracle Developer Installation Options dialog box.

Custom Installation or 
Removal

This option displays the Software Asset Manager, enabling you 
to choose the specific products you wish to install. (You can 
also use this option to remove products that have already been 
installed on your machine.)
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Installing Oracle Developer
to perform and click OK.

For a multiple-client installation:

In the Installation Options dialog box, choose Custom Installation or Removal 
and click OK.

1.2.2.1 Development or deployment installation
In a development or deployment installation, the appropriate subset of products 
will be automatically installed. You may be prompted with specific questions as the 
installation progresses. Oracle recommends that you accept the default product 
locations.

When installation is complete, exit the Oracle Installer and shut down and restart 
Windows. See Section 1.2.3 for continued instructions.

1.2.2.2 Custom installation
In a custom installation, the Software Asset Manager dialog box is displayed.

The products that are available for installation are listed under Products Available. 
The plus sign (+) to the left of a product’s name indicates that this is the name of a 
software package, which consists of a main application and its supporting software. 
You can select the entire package by clicking the line with the plus icon, or you can 
double-click that line to display the pieces of the package, which can be selected 
individually.

The products that are already installed on your machine are listed under Products 
Installed. Some of these may also be software packages, and they behave as 
described in the previous paragraph.

The disk space required for your selection and the disk space currently available on 
your machine are displayed in the Space Required area below the product lists.

The Software Asset Manager dialog box also contains the following buttons:

Button Description

Exit Closes the Software Asset Manager and exits the Oracle 
Installer.
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Installing Oracle Developer
1. Select the product or products you want to install in the Products Available list.

As with other Windows-based applications, you can Shift+click to select a series 
of products from the list, or you can Ctrl+click to select multiple, discontinuous 
products.

For a single-client installation:

Select the Oracle Developer products you wish to install.

For a multiple-client installation:

Select Oracle Client Configuration Manager, Oracle Client Software Agent, and 
Oracle Installer.

2. Click Install.

The installation begins. Oracle recommends that you accept the default product 
locations.

Options . . . Allows you to do the following:

■ Request confirmations before removing or installing 
products.

■ Receive detailed messages and prompts during various 
phases of the Oracle Installer’s function.

■ Record the actions being performed by the Oracle Installer 
in a log file.

View Log . . . Displays the Event Log. The Event Log displays installation 
and configuration events in the Description Level you choose: 
Summary, Brief, and Detail. You can store and retrieve logs and 
save them to files.

By default, log files are stored in %ORACLE_
HOME%\ORAINST\ORAINST.LOG. If a log file from a previous 
logging exists, it is renamed to ORAINST.OLG.

If you want to keep more than two log files (.LOG and .OLG), 
rename the .OLG file so that it is not overwritten.

Restore Icons Restores Oracle product icons that have been accidently 
deleted.

Help Displays the online Help system.

Button Description
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Installing Oracle Developer
For a multiple-client installation: When you are installing the Oracle Client 
Software Agent, a dialog displays asking you to enter the location for storage of 
client information.

■ The location can be outside the ORACLE_HOME directory, but if so, be 
sure to specify the full pathname. The default name for the location is 
Clients, but you can change it to any name.

■ Enter the machine share name under which the client directory will be 
shared for other clients to connect to. NOTE: This directory must be one 
which clients can write to.

3. When installation is complete, each product you have installed is listed in the 
Products Installed list.

4. Exit the Oracle Installer. Shut down and restart Windows.

For a multiple-client installation: See Section 1.3, "Using OCSM for a 
Multiple-Client Installation" for further instructions for a multiple-client 
installation.

1.2.3 Step 3: Building the database tables
As an optional step in your product installation, you or your database administrator 
may build the Oracle Developer database tables, which allow application modules 
to be saved to the Oracle Server. Chapter 2 gives instructions for building these 
tables.

The Oracle Translation Builder and Schema Builder components of Oracle 
Developer require the use of database tables. If you plan to use Translation Builder 
or Schema Builder, building the Oracle Developer database tables is a requirement.

CAUTION: If you are upgrading from a previous release of Oracle Developer and 
already have modules stored in the database, please be sure to read Section 2.5, 
"Upgrading the Oracle Developer Database Tables" for more information. 
Removing the existing tables or attempting to install the database tables for the 
current version of Oracle Developer destroys any Oracle Developer modules 
currently stored in the database.

1.2.3.1 Oracle Developer demo database tables
If you have installed and want to use the Oracle Developer demos, you will need to 
create and populate the demo database tables.
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To create and populate the demo database tables:

■ Click Start→Programs→Oracle Developer R6.0 Demos→Install Demo 
Database Objects.

This menu item runs the following SQL script:

%ORACLE_HOME%\TOOLS\DEVDEM60\ADMIN\DEMOS601.SQL

See Chapter 2 for more information on database tables.

1.2.4 Step 4: Configuring the Oracle Developer Server
If you plan to deploy your applications on the Web, you need to configure the 
Oracle Developer Server for Web application deployment.

To configure the Oracle Developer Server:

1. (Optional) Install the Oracle Web Application Server 4.0. The Oracle Web 
Application Server is required only if you intend to deploy your applications as 
application cartridges.

For more information about cartridge and non-cartridge implementations, refer 
to the Oracle Developer: Guidelines for Building Applications manual.

2. Choose Start→Oracle Developer→Oracle Developer Server Configuration 
Wizard to launch the configuration utility.

For more information about configuring the Oracle Developer Server, refer to 
D2KCFG.HTM, which is located in %ORACLE_HOME%\TOOLS\DOC60.

1.2.5 Creating reports using Express
If you will be creating reports that use Express data, see Appendix A for more 
information.

1.3 Using OCSM for a Multiple-Client Installation
Oracle Client Software Manager is a feature incorporated into the Oracle Installer. It 
is based on a central OCSM host from which administrators distribute products to 
client machines. Once a client machine is registered with the host, client users can 
easily keep their machines up to date with the products configured for them on the 
OCSM host machine.

There are four steps necessary to use OCSM for a multiple-client installation. They 
are described in detail in the following sections.
Installing Oracle Developer 1-9
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1. Set up the OCSM host machine:

a. Install Oracle Client Configuration Manager, Oracle Client Software Agent, 
and Oracle Installer.

b. Grant clients access to OCSM host machine.

c. Install products for distribution on OCSM host machine.

2. Register clients with OCSM host machine.

3. Configure clients using OCCM on host machine.

4. Install products on client machines using OCSA.

1.3.1 Step 1: Setting up the OCSM host machine
There are three steps involved in setting up the OCSM host machine:

1. Install Oracle Client Configuration Manager, Oracle Client Software Agent, and 
Oracle Installer.

2. Grant clients access to OCSM host machine.

3. Install products for distribution on OCSM host machine.

1.3.1.1 Installing OCCM, OCSA, and the Oracle Installer
Follow the instructions in Section 1.2 to install Oracle Client Configuration Manger, 
Oracle Client Software Agent, and the Oracle Installer on the OCSM host machine.

1.3.1.2 Granting client access to OCSM host machine
After installing the Oracle Client Configuration Manager on the file server, verify 
that you have granted the following client access permissions:

■ Read access to the host’s ORACLE_HOME directory

■ Read and write access to the host’s %ORACLE_HOME%\CLIENTS subdirectory.

The Oracle Client Software Agent writes to this directory. It must be shared 
explicity under the name specified during OCSA installation. (See the 
multiple-client installation instructions in Section 1.2.2.2 for more information.)

■ Access to the registry.

Note: In a NetWare environment, you must also grant Create access to clients.

This section provides instructions for granting permissions on client machines with 
Windows NT or Windows 95.
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1.3.1.2.1 Windows NT  When the OCSM host machine runs Windows NT, all client 
machines registering with this host machine must also be running Windows NT.

To allocate access privileges for OCSM clients with Windows NT:

1. Run REGEDT32.EXE on the OCSM host machine.

2. Select HKEY_LOCAL_MACHINE and choose Security→Permission.

3. Be sure each OCSM client has read access.

1.3.1.2.2 Windows 95  When the OCSM host machine runs Windows 95, all client 
machines registering to this host machine must also be running Windows 95.

To allocate access privileges for the various OCSM clients with Windows 95, first 
you must install Microsoft Remote Registry Services on both the OCSM host and 
client machines. Second, you grant client permissions on the host machine.

WARNING: In Windows 95, you cannot give clients read-only access to the Host 
machine’s registry. OSCM clients can write to the host machine’s registry and may 
present a security risk. 

To install Microsoft Remote Registry services (on host and client machines):

1. Insert the Windows 95 CD.

2. Double-click Network from the Control panel.

3. Click Add. 

4. Double-click Service. 

5. Click Have Disk. 

6. Type the path (where D is the drive letter for your CD-ROM drive):

D:\ADMIN\NETTOOLS\REMOTREG

7. Click OK to start the installation.

8. Click OK.

9. Click Microsoft Remote Registry.

10. Click OK.

Note: If you are prompted to specify the location of additional files, specify the path 
to the Windows 95 source files on a shared directory or on the Windows 95 CD.

To allocate access privileges for OCSM clients with Windows 95:
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Using OCSM for a Multiple-Client Installation
1. On the OCSM host machine, double-click Access Control from the Control 
Panel. 

2. Select the User-level Access Control option.

3. Type the domain in which the OCSM client users exist.

4. At the Control Panel, double-click Passwords. 

5. Select the Remote Administration tab.

6. Select the Enable Remote administration of this server option.

7. Enter and confirm the password.

8. Click OK.

1.3.1.3 Installing products for distribution on OCSM host machine
Follow the instructions in Section 1.2 to install on the OCSM host machine the 
products you wish to distribute to the clients.

1.3.2 Step 2: Registering clients with the OCSM host machine
To register a client machine with the OCSM host machine, the client must connect a 
network drive to the OCSM host’s ORACLE_HOME directory and then run 
SHARAGT.EXE. This program places the Oracle Client Software Agent (OCSA) icon 
in the Windows startup group. OCSA is then invoked whenever Windows is started 
or when a client user double-clicks the icon.

To register a client with the OCSM host machine:

1. On the client machine, map a network drive to the OCSM host’s ORACLE_
HOME directory.

2. Run BIN\SHARAGT.EXE from the host’s ORACLE_HOME directory.

3. When prompted for the client name, enter an appropriate name.

The name you enter here will be used in the Oracle Client Configuration 
Manager on the host.

4. When prompted for the client ORACLE_HOME directory, enter it. This is the 
area where Oracle products are installed locally.

When the program exits, the Oracle Client Software Agent icon is placed in th 
Oracle for Windows NT or Oracle for Windows 95 startup group.
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1.3.3 Step 3: Configuring clients using OCCM on the host machine
Start the Oracle Client Configuration Manager from the appropriate 
Start→Programs menu from the taskbar.

The window displays three different views, which you can select from the View 
drop-down list.

Figure 1–2 Configuration Definitions view

In the Configuration Definitions view, you define configurations containing 
subsets of the available products.
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Figure 1–3 Client Assignments view

In the Client Assignments view, you assign clients to specific configurations.
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Figure 1–4 Install Options (Configurations and Conflict Resolution) view

In the Install Options (Configurations and Conflict Resolution) view, you can 
specify client installation options and means of resolving configuration installation 
conflicts.

The Oracle Client Configuration Manager dialog box also contains the following 
buttons:

Button Description

OK Save all changes and close the window.

Reset This Clear changes in the currently displayed page, for the currently 
displayed configuration only. All other changes are kept.

Reset All Clear changes on all pages, for all configurations. Effectively 
returns the tool to the state it was in when it was opened.

Cancel Close the window without saving any changes.
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To configure clients, you must complete the following tasks, described in detail in 
the sections below:

■ Define configurations.

■ Select products for the configurations.

■ Assign clients to the configurations.

■ Define installation options.

■ Resolve installation conflicts.

1.3.3.1 Defining configurations
To define configurations:

1. Click the drop-down list and choose Configuration Definitions.

2. To add a configuration:

Click Add, then type the name of the new configuration in the dialog box.

To remove a configuration:

Cick Remove, then click OK in the dialog box to confirm that you want the 
current selection to be deleted.

1.3.3.2 Selecting products for the configuration
The Available Products list displays all products on the host that are not already 
included in the configuration. Products that are included in the configuration are 
listed under Selected Products.

To add a product:

1. In the Available Products area, select the product you want to add to the 
configuration. You can select multiple products using Shift+click or Ctrl+click.

2. Click Add.

The selected products and their dependencies are added to the Selected 
Products list for the configuration.

Help Display the online Help system.

Button Description
1-16



Using OCSM for a Multiple-Client Installation
To remove a product:

1. In the Selected Products area, select the product you want to remove from the 
configuration. You can select multiple products using Shift+click or Ctrl+click.

2. Click Remove.

1.3.3.3 Assigning clients to configurations
Assigning a client to a configuration specifies which products should be installed on 
the client and the manner in which they should be installed.

1. Click the drop-down list, and choose Client Assignments.

2. In the Configuration box, select a configuration.

The list of clients on the host that are not already assigned to the selected 
configuration appears in the Available Clients list.

3. To add a client:

a. Select the desired client in the Available Clients list. You can select multiple 
clients using Shift+click or Ctrl+click.

b. Click Add.

The selection appears in the Selected Clients list.

To remove a client:

a. Select the desired client in the Selected Clients list. You can select multiple 
clients using Shift+click or Ctrl+click.

b. Click Remove.

1.3.3.4 Defining installation options
Within a configuration, the install options control the way the products are installed 
on the named clients.

1. Click the drop-down menu and choose Install Options (Configurations and 
Conflict Resolution).

2. Select a configuration from the list.

The Client Installation Options for the selected configuration appear.

3. If the products in the configuration must be installed in a specific way:

a. Select the checkbox Force Executable Location.
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b. Select an installation option from the list:

Run from OCSM Host   All product files are kept on the OCSM Host. This 
saves disk space on the client, but the software runs more slowly because 
the client must run the software over the network.

Download EXE/DLL to Client Machine   Configuration files, EXEs, DLLs, 
and other binaries are downloaded to the client machine. This type of 
installation improves performance over the first option, because executables 
run locally.

Install Completely on Client Machine   All product files are fully 
replicated on the client machine. This type of installation takes up more 
disk space than a partial download, but the client can run the software even 
when completely disconnected from the host machine.

Note: If you do not select Force Executable Location, clients may choose how to 
install the products.

4. To require that all products you select for the configuration be installed for 
client use, select Force Client Installation.

Note: If you do not select Force Client Installation, the Installer prompts clients 
for which products to install from among the list of products you specified for 
the configuration.

1.3.3.5 Resolving installation conflicts
If a client belongs to more than one configuration, and some options are set 
differently for the two configurations, a conflict arises. If there is a conflict, settings 
made in the Conflict Resolution section take precedence over individual settings for 
configurations. The Conflict Resolution section contains the same options as the 
Client Installation Options section.

To save the setting, click OK.

1.3.4 Step 4: Installing products on client machines using OCSA
You use the Oracle Client Software Agent (OCSA) to bring the client machine up to 
date with respect to the OCSM host machine. The client is updated automatically 
when Windows is started, but can also be updated manually using OCSA.

To update the client machine manually:

Double-click the Oracle Client Software Agent icon in the startup folder.
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To determine whether the client environment needs to be updated with respect to 
the OCSM host environment, the Oracle Client Software Agent compares the client 
timestamp in the local ORACLE portion of the registry to the client timestamp in 
the CLIENTS.INI file in the OCSM host’s ORACLE_HOME directory. When the 
local timestamp count is earlier than the CLIENTS.INI timestamp, the client is not 
up to date, and the Agent invokes the Installer in configuration mode. Otherwise, 
the local client environment is up to date and the Oracle Client Software Agent 
exits.

1.4 Upgrading from a Previous Release
If you are upgrading from an Oracle CDE or Oracle Developer Release 1 or Release 
2 product to Oracle Developer Release 6.0, you must upgrade all the components 
you have installed. Because of improvements to the underlying support files, such 
as the Tools Utilities, GUI Common files, and Required Support Files, the older set 
of components cannot run with the newer set.

CAUTION: Do not install or build the Oracle Developer database tables until you 
run the appropriate upgrade script. Refer to Chapter 2 for more information. If you 
have customized your product resource (.RES) files (e.g., fmrusw.res) you should 
back up these files as well before upgrading.

1.4.1 Upgrading to Oracle Developer Release 6.0 on Windows 95 or Windows NT
If you have used previous versions of Oracle Developer on Microsoft Windows 3.x, 
your ORACLE_HOME directory was called ORAWIN.

If you have since upgraded your operating system to Windows 95 or Windows NT, 
your new installation of Oracle Developer Release 6.0 creates a new ORACLE_
HOME directory. This new directory is named either ORAWIN95 (on Windows 95) 
or ORANT (on Windows NT). In either case, your old ORAWIN directory is not 
overwritten.

1.4.2 Upgrading your applications
If you are upgrading applications that were created using a previous version of 
Oracle Developer, please keep in mind the following information.

■ If you want to run an application that was built using a 16-bit version of Oracle 
Developer, you need to recompile that application using the 32-bit version of 
Oracle Developer on either Windows 95 or Windows NT.
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You can streamline the compilation process using Project Builder:

1. Create a new project.

2. Add all your source files to the new project.

3. Choose Project→Compile All.

Please see the Project Builder online help for more information on compiling 
projects.

See the Form Builder, Graphics Builder, and Report Builder online help for 
more information on upgrading applications created using older versions of 
Oracle Developer.

■ If you are upgrading applications that use user exits and user-created DLLs, 
those DLL files may need to be recompiled after recompiling your applications 
with the new release.

■ Applications that use VBX controls do not run properly under Windows 95 due 
to an operating system incompatibility between 16-bit VBX controls and 32-bit 
executables.

■ Applications that make calls through the Oracle Developer foreign function 
interface (ORA_FFI package) to 16-bit DLLs do not work under Windows 95 
due to an operating system incompatibility between 16-bit code and 32-bit 
executables.

■ Oracle Reports Release 6.0 includes a PL/SQL conversion utility for converting 
modules based on PL/SQL V1 or V2 to PL/SQL version 8, which is the version 
Release 6.0 is based on. If you are upgrading from a release prior to Oracle 
Reports Release 2.0, you will need to convert all modules (Forms, Reports, 
Graphics, and PL/SQL libraries) to the newer version of PL/SQL. The 
conversion utility runs automatically whenever you open a module containing 
PL/SQL V1 or V2, allowing you to interactively perform the conversion. The 
conversion can also be run automatically in batch mode, and using Project 
Builder, a large number of modules can be converted without user intervention.

See the online help for Project Builder, Form Builder, Report Builder, and 
Graphics Builder for more detailed information on the PL/SQL conversion 
utility.

Note: Oracle strongly recommends that you make a backup of all modules 
before beginning the conversion process.

Note: The Windows 3.x 64K limit on the size of compiled PL/SQL program units 
does not apply on Windows 95.
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1.5 Removing Oracle Products
You can use the Oracle Installer to remove an Oracle product from your system. 
Removing a product de-installs all product files and subdirectories associated with 
the product.

To remove a product from your system:

1. Start the Oracle Installer from your Oracle product media or file system. See 
Section 1.2.1 for instructions on starting the Oracle Installer.

2. In the Installation Options dialog, select Custom Installation or Removal.

3. Select the product you want to remove from those listed in the Products 
Installed window.

4. Click Remove. If the products you select to de-install affect other products, 
Oracle Developer displays a confirmation prompt before de-installing.

Note: If you are not using the standard Windows application to control your 
desktop (if you are using Central Point PC Tools or Norton Desktop, for example), 
the Oracle Installer may not remove program items correctly.
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Building and Maintaining the Database

Tables

This chapter describes administrative procedures that system administrators should 
follow after installing Oracle Developer. If you are not a system administrator, you 
do not need to reference the information in this chapter.

The following topics are included:

■ Building the Oracle Developer Database Tables

■ Using the Database Tables

■ Granting and Revoking User Access

■ Deleting the Oracle Developer Database Tables

■ Upgrading the Oracle Developer Database Tables

2.1 Building the Oracle Developer Database Tables
WARNING: These instructions are for new installations only. If you already have 
database tables installed for a previous version of a Oracle Developer product, be 
aware that removing the existing tables or attempting to install the database tables 
for the current version of Oracle Developer will destroy any Oracle Developer 
module currently stored in the database. Please see Section 2.5, "Upgrading the 
Oracle Developer Database Tables" on page 2-4 for instructions on upgrading 
database tables.

When you create applications with Oracle Developer, you can either save your 
modules as files or save them to the Oracle Server. Saving modules to the server 
conserves disk space on client machines and allows shared access to the modules, 
although access to modules stored on the server can be slower than when they are 
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stored as files on the client machine. You may wish to consider the following 
information when deciding where to store your modules.

Before users can save modules to the server, you must build tables to accommodate 
the modules and grant access privileges to users who will work with them. 

2.1.1 Step 1: Installing the SQL scripts with the Oracle Installer
If you have not already done so, use the Oracle Installer to install the SQL scripts 
needed to build and administer the Oracle Developer database tables.

To install the SQL scripts:

1. Start the Oracle Installer and select Custom Installation or Removal from the 
Oracle Developer Installation Options dialog box. (Refer to Chapter 1 for more 
information on the Oracle Installer.)

2. Select Oracle Developer Database Tables from the Available Products list.

3. Click Install.

Installing these scripts creates a Start menu item called Oracle Developer R6.0 
Admin and the associated submenu items Oracle Developer Build, Oracle 
Developer Drop, Oracle Developer Grant, and Oracle Developer Revoke. These 
menu items, when selected, run a script or a series of scripts to perform database 
administration tasks.

2.1.2 Step 2: Building the Oracle Developer database tables
To build the Oracle Developer database tables:

■ Click Start→Programs→Oracle Developer R6.0 Admin→Oracle Developer 
Build.

Storage Location When to Use

Database server ■ When you want security that is not provided by your 
operating system.

■ When you want to store applications on the client machine, 
but you do not have enough disk space.

■ When you want to share applications with other users.

■ When module access speed is not as important as the 
considerations listed above.

File system When the above criteria are not true or not important.
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This menu item runs the following SQL script:

%ORACLE_HOME%\TOOLS\DBTAB60\DEVBILD.SQL

2.2 Using the Database Tables
The database tables are intended to be used only by the Oracle Developer Builders 
for storing modules. The structure and organization of the tables is likely to change 
from release to release, so we strongly recommend that you do not try to use SQL 
queries against the tables to produce reports or documentation about your modules. 
Use of the tables in this way is not supported by Oracle, and for that reason the 
structure and content of the tables are not provided.

2.3 Granting and Revoking User Access
After building the Oracle Developer database tables, you must grant (and, later, 
revoke) user access to the tables.

2.3.1 Granting access to the Oracle Developer database tables 
You must perform this task for each user who requires access to the tables. 
Alternatively, you can grant access to all users simultaneously by granting access 
for user PUBLIC. 

To grant access to the Oracle Developer database tables:

■ Click Start→Programs→Oracle Developer R6.0 Admin→Oracle Developer 
Grant. You will be prompted to enter a username.

This menu item runs the following SQL script:

%ORACLE_HOME%\TOOLS\DBTAB60\DEVGRNT.SQL username

2.3.2 Revoking access to the Oracle Developer database tables 
You must perform this task for each user whose access to the tables you want to 
revoke. Alternatively, you can revoke access for all users simultaneously by 
revoking access for user PUBLIC. 

To revoke access to the Oracle Developer database tables:

■ Click Start→Programs→Oracle Developer R6.0 Admin→Oracle Developer 
Revoke. You will be prompted to enter a username.
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This menu item runs the following SQL script:

%ORACLE_HOME%\TOOLS\DBTAB60\DEVRVKE.SQL username

2.4 Deleting the Oracle Developer Database Tables
WARNING: Deleting the database tables erases any module stored in those tables. 
Do not delete database tables until you have verified that you do not need any 
module currently stored in the table or tables you intend to delete. See Section 2.5.1 
for more information on backing up modules currently stored in your database.

To delete the Oracle Developer database tables:

■ Click Start→Programs→Oracle Developer R6.0 Admin→Oracle Developer 
Drop.

This menu item runs the following SQL script:

%ORACLE_HOME%\TOOLS\DBTAB60\DEVDRP.SQL

2.5 Upgrading the Oracle Developer Database Tables
If you are upgrading from a version of Oracle Developer prior to Release 2.0, you 
can run one or more upgrade scripts instead of creating the tables from scratch. 
Doing so updates the information in your tables (preserving your existing 
information) rather than rebuilding the tables.

Note: Once you upgrade from a previous version, you must grant user access to the 
database tables again. See Section 2.3 for information about how to do this.

2.5.1 Step 1: Backing up the database
If you have any modules stored in the database that you wish to continue using 
after upgrading the database tables, you will need to back up these modules. Any 
modules that you do not back up will be lost.

To list all modules currently stored in the database, use the following SQL script:

column product format a15
column modtype format a15
SELECT product, modtype, owner, modname
FROM tool_module
ORDER BY product, modtype, owner;
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To back up a module:

1. Open the module in the appropriate Builder.

2. Save the module as an operating system file using the File→Save As command.

Once you have completed upgrading the database tables, you can restore the 
modules to the database.

To restore a module:

1. Open the module in the appropriate Builder.

2. Save the module as a database module using the File→Save As command.

The source files for your applications consist of the following:

■ Form Builder: .FMB, .MMB, and .PLL files

■ Report Builder: .RDF and .SQL files 

■ Graphics Builder: .OGD files

■ Procedure Builder: .PLL files

■ Query Builder: .BRW and .SQL files

2.5.2 Step 2: Upgrading the tables
Once you have backed up the database, you can upgrade the database tables.

2.5.2.1 Common tables
There has been no change to the underlying structure of the Oracle Developer 
common tables, so no upgrade is necessary.

2.5.2.2 Form Builder
There has been no change to the underlying table structure in Form Builder, so no 
upgrade is necessary.

2.5.2.3 Report Builder
If you have any modules stored in the Report Builder database tables from a release 
of Oracle Developer prior to Release 2.0, perform the following steps.

Note: All SQL scripts should be run under the SYSTEM account.

1. Back up the existing database tables and modules. (See Section 2.5.1 for details.)
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2. Upgrade the existing tables by running the following script:

%ORACLE_HOME%\TOOLS\DBTAB60\REPORT60\SRW6000.SQL

3. Grant access to the tables by running the following script:

%ORACLE_HOME%\TOOLS\DBTAB60\REPORT60\SRW6GRNT.SQL

2.5.2.4 Graphics Builder
There has been no change to the underlying table structure in Graphics Builder, so 
no upgrade is necessary.

2.5.2.5 Procedure Builder
There has been no change to the underlying table structure in Procedure Builder, so 
no upgrade is necessary.

2.5.2.6 Query Builder
There has been no change to the underlying table structure in Query Builder, so no 
upgrade is necessary.

2.5.2.7 Schema Builder
There has been no change to the underlying table structure in Schema Builder, so no 
upgrade is necessary.

2.5.2.8 Translation Builder
If you have any modules stored in the Translation Builder database tables from a 
release prior to Oracle Developer Release 2.0, perform the following steps.

Note: All SQL scripts should be run under the SYSTEM account.

1. Back up the existing database tables and modules. (See Section 2.5.1 for details.)

2. Upgrade the existing tables by running the following script:

%ORACLE_HOME%\TOOLS\DBTAB60\OTM60\SQLMIG.SQL
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This chapter contains information about benefits and features of Oracle Developer 
Release 6.0, product overviews of each of the Oracle Developer components, and 
instructions for viewing Oracle Developer online help.

The chapter is arranged into the following sections:

■ About Oracle Developer: Features and Benefits

■ About Project Builder

■ About Form Builder

■ About Graphics Builder

■ About Report Builder

■ About Procedure Builder

■ About Query Builder

■ About Schema Builder

■ About Translation Builder

■ About Oracle Developer Documentation

3.1 About Oracle Developer: Features and Benefits
Oracle Developer is a multi-tier Web and client/server development tool for 
building scalable applications that run on all major platforms. It incorporates an 
integrated set of builders for creating forms, reports, charts, queries, and 
procedures. The declarative capabilities of these components enable you to create 
applications from database definitions without the need to write any code.

Oracle Developer offers the following features and benefits:
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■ Productivity enhancements

■ Web deployment of applications

■ Scalability

■ Openness

3.1.1 Productivity
Oracle Developer employs rapid application design (RAD) techniques, object 
orientation, built-in computer-based training, and a unified client-server 
architecture to enhance productivity. Creating applications is simplified via 
re-entrant wizards and through inheritance of reusable components. Oracle 
Developer applications can also be created directly from models created using 
Oracle Designer (CASE).

Oracle Developer offers an environment for development teams of all sizes. The 
new, integrated Project Builder manages all application components and external 
components (such as multimedia content), and enables the components to be 
opened with the appropriate tool. Project Builder increases productivity by 
facilitating deployment of completed applications. You can use Project Builder to 
package applications into a .tar or .zip file and create your own installation scripts 
for use with the Oracle Installer. Configuration management, including check-in, 
check-out, version labeling, auto-recompilation, and difference reporting are all 
provided through interfaces to popular source- and version-control packages.

3.1.2 Web Deployment
Oracle Developer enables developers to deploy new and existing applications on 
the World Wide Web, either on an internal company intranet or on the Internet. 
Oracle Developer takes advantage of the ease and accessibility of the Web, elevating 
it from a static information-publishing mechanism to an environment capable of 
supporting complex, dynamic applications. Form Builder applications and Graphics 
Builder displays generated for the Web have the same rich interactive GUI 
environment as those generated for client/server, coupled with the scalability 
expected of mission-critical, transaction-intensive applications. Reports generated 
for the Web provide the degree of presentation quality and precision that is critical 
for publishing enterprise-wide information.
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3.1.3 Scalability
Scalability is inherent in the multi-tiered architecture of the product. It is explicit in 
the support for server functionality, such as array DML, database cursors, bind 
variables, savepoints, and result sets, and it is definitive in the drag-and-drop 
client/server object partitioning which dramatically reduces network traffic 
between client and server. Oracle Developer’s flexible multi-tier architecture 
supports Oracle7 and Oracle8 application servers or third-party application servers 
such as TP monitors, ensuring scalability from the desktop to the enterprise.

3.1.4 Openness
Standards-based interaction between Oracle Developer and other applications and 
tools is enabled through Java Beans, ActiveX controls, OLE (Object Linking and 
Embedding), and DDE (Dynamic Data Exchange). Support for a variety of 
multimedia formats is complemented by an open architecture, giving developers 
the flexibility to extend Oracle Developer applications and integrate other 
components into them.

Oracle Developer offers integration with Oracle databases as well as transparent 
access to all major databases including Rdb, SQL Server, Informix, Sybase, and 
DB/2. Database access is provided through ODBC database drivers as well as 
through the Oracle Gateways.

A number of interfaces to third-party products are available from members of the 
Open Tools Initiative. These interfaces include configuration management tools, 
CASE and modeling tools, workflow engines, transaction processing (TP) monitors, 
and many others.

3.2 About Project Builder
Project Builder helps you organize and maintain the many different files that make 
up an application. Within a single project, you can track everything from 
application documentation created using your favorite word processor, to forms, 
reports, and the charts they contain, as well as user exits and the routines they call. 
Project Builder is able to provide a single point of contact for you by integrating all 
the tools, files, and tasks that make up a development project.

3.2.1 Major concepts
A project is a collection of pointers to the files you consider part of your application. 
Within projects, you can define the editors, compilers, and other tools you use to 
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work with project files. Project files can be shared and ported across platforms. 
Subprojects are projects that are contained within other project files, rather than 
being stored in their own files. Subprojects are useful when you want to further 
group all items relating to a specific part of an application. You can, for example, 
create a subproject containing the charts, menus, libraries, and documents that 
comprise a large form.

The Project Wizard is a quick and easy way to create a project. You can use the 
Project Wizard to create a project registry file, which provides a means for you to 
associate the files that make up an application, thus enabling you to manage the 
application-building process more efficiently. The Wizard leads you through the 
steps necessary to define a project. You can define a new standalone project or a 
subproject, name your project, select the directory in which it will reside, and 
specify a default connection. When you complete the Project Wizard, you’ll be 
ready to start adding files.

The Global Registry stores information common to an entire Oracle Developer 
installation. This information is restricted to type definitions and their associated 
actions, and built-in or user-defined properties. The use of the Global Registry is 
optional; its functions can be performed by individual user registries.

User registries store configuration information on a per-user basis. Each user 
registry inherits type information from the Global Registry and may contain new 
types defined by the individual user. The user registry may also override aspects of 
type definitions it inherits from the Global Registry. A user registry also stores 
environment and preference information, such as preferred connect strings, UI 
settings, and certain general project information.

3.2.2 Process
To build a project using Project Builder, you perform the following steps:

1. Create a new project using the Project Wizard.

2. Add items (types, actions, macros, and files) to your project.

3. Build project and deliver application.

3.3 About Form Builder
Form Builder is a development tool for building applications that provide users 
access to information stored in a database. Form Builder modules can run 
standalone, and they can also call reports and have graphics embedded in them.
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3.3.1 Major concepts
When you create a Form Builder application, you work with three types of 
modules: forms, menus, and libraries. A form module is a collection of objects and 
data that users interact with in order to modify database tables. They make up the 
main body of a Form Builder application, and they contain any of the user interface 
items as well as the data source definitions and behavior. A menu module is 
comprised of menus and menu code. Users choose menu items to execute 
application functions. A library module is a collection of client-side code that can be 
shared across modules and applications.

The Object Navigator provides a hierarchical display of all the objects in the 
application.

The Data Block Wizard enables you to easily create or modify data blocks for use in 
your application. The Data Block Wizard can be reentered after initial creation of the 
data block, enabling you to modify an existing data block, even if it was not 
originally created with the wizard.

The Object Libraries provide an easy method of reusing objects and enforcing 
standards across the entire development organization.

The Layout Wizard enables you to quickly lay out the items of a data block. The 
wizard displays the items in a frame on a canvas and lays them out in one of several 
layout styles, after which you can manually alter the layout to your own 
specifications. You can reenter the Layout Wizard after the initial creation of a 
frame, enabling you to modify an existing frame, even if it was not created with the 
Layout Wizard.

The Property Palette enables you to set the properties of objects you create in form 
and menu modules. When you select an object in an editor or in the Object 
Navigator, the Property Palette updates to show the properties of that object. When 
you need to compare the properties of two different objects, you can invoke 
additional Property Palettes as needed.

The integrated PL/SQL Editor enables you to write PL/SQL code from within Form 
Builder. It provides a graphical interface for editing and debugging both client- and 
server-side functions and procedures.

3.3.2 Process
To build a Form Builder application, you perform the following steps:

1. Create modules using the Object Navigator.

2. Create blocks and items manually or by using the Data Block Wizard.
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3. Apply user interface standards to your objects using the Object Library.

4. Fine-tune the layout using the Layout Wizard or the Layout Editor.

5. Set properties using the Property Palette.

6. Add code using the PL/SQL Editor.

7. Test your application using the Forms Runtime component and the integrated 
source-level debugger.

3.4 About Graphics Builder
Graphics Builder enables you to produce interactive graphical displays that 
represent and interact with data visually. A display is a combination of data and 
behavior, encapsulated in a self-contained graphical application. This enables you to 
reuse your displays and embed them in a form or a report.

3.4.1 Major concepts
An application created in Graphics Builder is called a display. A display contains all 
components used in the application, including data source definitions, visual 
elements, and behavior. Each display contains a layout, on which the display’s 
graphical objects are drawn. The layout consists of one or more layers containing 
individual visual elements of the display. At runtime, you can hide, show, and 
rearrange layers to present different graphical views to the user. All other 
components of the application, such as data queries and PL/SQL constructs, are 
also part of the display.

There are over fifty predefined common chart styles, and you can also use a full set 
of drawing tools to create custom graphical displays such as interactive maps and 
import a wide range of image formats. You can use the Layout Editor to create and 
modify the graphical objects themselves.

The Object Navigator provides a hierarchical display of all the objects in the display.

The Chart Wizard enables you to quickly create a chart, select a data source, and 
create a query to specify the data to be plotted in the chart. You can reenter the 
Chart Wizard after the initial creation of a display, enabling you to modify an 
existing display, even if it was not originally created with the Chart Wizard.

The Property Palette enables you to set the properties of objects in displays. When 
you select an object in the Object Navigator, the Property Palette updates to show 
the properties of that object. When you need to compare the properties of two 
different objects, you can invoke additional Property Palettes as needed.
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The integrated PL/SQL Editor enables you to write PL/SQL code from within 
Graphics Builder. It provides a graphical interface for editing and debugging both 
client- and server-side functions and procedures.

3.4.2 Process
To create a chart object using one of the predefined chart styles in Graphics Builder, 
you perform the following steps:

1. Use the Chart Wizard to create a chart object, select a data source, and create a 
query to specify the data to be plotted in the chart.

2. Select a chart type from the Chart Properties sheet.

3. Modify the chart and chart element properties as necessary.

4. Add code using the PL/SQL Editor.

5. Test your application using the Report Builder or Form Builder Runtime 
component and the integrated source-level debugger.

6. Integrate the display with a form module.

3.5 About Report Builder
Report Builder enables you to develop production-quality reports in a client/server 
or Web environment. You can deploy reports on the Web using the Reports Server 
and Reports Web CGI or Reports Cartridge. Reports can be run standalone, or you 
can run them from forms or Graphics Builder displays. 

3.5.1 Major concepts
A report is a collection of objects defining its data, layout, and runtime interface.

To quickly create new reports, you use the Report Wizard. The wizard guides you 
through the process of choosing a report type, defining a data model, and laying out 
the data. You can reenter the Report Wizard after the initial creation of a report, so 
you may re-invoke it on an existing report, make changes, and re-default the report, 
even if the report was not originally created with the Report Wizard.

When you complete the Report Wizard, your report is displayed in the Report 
Editor’s Live Previewer. The Live Previewer is a WYSIWYG editing environment 
for making basic changes to your report layout. For more complex report editing, 
you can use the Report Editor’s Data Model, Layout Model, and Parameter Form 
views. (All of the Report Editor’s views are accessible from the View menu.) You 
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can generate HTML or PDF output from your report with the click of a toolbar 
button.

To run reports on remote servers, you use the Reports Multi-tier Server (hereafter 
referred to as the Reports Server). The Reports Server accepts job requests from 
client machines and maintains a request queue. You can view and administer the 
queue with the Reports Queue Manager (rwrqm60.exe).

To dynamically run reports from a Web client, you use the Reports Server in 
combination with the Reports Web Cartridge or Web CGI. The Reports Web 
Cartridge or Web CGI enables your Web server to send report requests to the 
Reports Server for execution and receive the report output back in the Web browser.

If you have already installed the Oracle Developer Server and the Oracle Web 
Application Server, you can automatically configure the Reports Server, and Web 
Cartridge or Web CGI with the Easy Configuration tool.  To launch the Easy 
Configuration tool, choose Start→Oracle Developer→Easy Configuration.  For 
instructions on how to manually configure the Reports Server, and Web Cartridge 
or Web CGI, refer to d2kcfg.htm in %ORACLE_HOME%\TOOLS\DOC60.

3.5.2 Process
To build a report using Report Builder, you perform the following steps:

1. Use the Report Wizard to create a report.

2. Edit the Report in the Live Previewer, Data Model, Layout Model, and 
Parameter Form views of the Report Editor.

3. Run the report to the desired format and destination, such as PostScript printer, 
HTML file, or PDF file.

3.6 About Procedure Builder
Procedure Builder is a unified environment for developing and maintaining 
client/server application code.

3.6.1 Major concepts
Procedure Builder provides a graphical user interface for creating, editing, and 
compiling both client- and server-side PL/SQL, including program units, libraries, 
and database triggers. The Object Navigator provides a hierarchical display of these 
objects and enables you to launch any Procedure Builder editors or dialogs. You can 
drag and drop objects in the Object Navigator to change the relationships between 
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them, and you can partition your applications by dragging and dropping 
procedural logic between client and server. Because Procedure Builder is embedded 
in Form Builder, Report Builder, and Graphics Builder, you can also drag and drop 
PL/SQL in the same way in those Builders.

The Program Unit Editor provides you with full text editing capabilities for entering 
and editing your program unit source code. You can also use the Program Unit 
Editor to compile program units and troubleshoot PL/SQL syntax errors with an 
interactive error message window.

The Database Trigger Editor provides a graphical interface for creating database 
triggers.

The Interpreter is the central debugging workspace in which you can set debug 
actions and test the program unit in runtime simulation. Breakpoints suspend 
execution of a compiled program unit, enabling you to step through code and 
troubleshoot runtime errors. Due to Procedure Builder’s integrated client-server 
environment, debugging stored program units involves the same process as 
debugging local program units.

Libraries are collections of program units that you can store on the client or server 
for easy reuse by multiple applications. Libraries also offer performance benefits 
because library program units are not loaded into memory until they are called. 
Program units in attached libraries are loaded into memory only when they are 
needed by the application, and are searched for through all attached libraries in the 
order indicated by the Object Navigator hierarchy.

3.6.2 Process
To create a program unit with Procedure Builder, you perform the following steps:

1. Use the GUI editor to create and compile PL/SQL program units.

2. Test the program unit in runtime simulation.

3. Perform debugging actions by controlling the flow of execution and examining 
program state.

4. Iterate through the development cycle incrementally. Test program units 
immediately after incorporating changes.

3.7 About Query Builder
Query Builder provides an intuitive means to access information from your 
organization’s databases for analysis and reporting. Query Builder displays your 
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tables graphically, providing visual assistance as you use the point-and-click 
interface to create a single query.

3.7.1 Major concepts
Each table in a query appears as a box in the Query window. The columns that 
make up a table are listed in the Query window under the table name.

The Query window is divided into two panels, the Conditions panel and the 
Datasource panel. In the Datasource panel you specify which tables to include in 
your query and which columns to query from those tables. Query Builder 
understands the relationships between tables and displays those relationships 
graphically, using a relationship line. You can place conditions involving 
comparisons, character matches, or nulls, as well as using multiple conditions in a 
query.

You can sort query results, generate summary calculations, and use data from 
different parts of the database. You can also perform calculations on the data to 
construct what-if scenarios and forecasts, change fonts and formats, print and save 
retrieved data, and export data to other applications such as Lotus 1-2-3 and 
Microsoft Excel.

Query Builder displays the requested data in the Results window.

The Data Editor enables you to insert, update, and delete database rows. It performs 
SQL Data Manipulation Language (DML) commands used to edit the data in your 
database.

Note: Because the Data Editor enables you to change or delete data, Query Builder 
is shipped with the Data Editor disabled. You cannot access it unless you have the 
proper database privileges and the Data Editor has been enabled on the server side 
by your database administrator.

3.7.2 Process
To create a query using Query Builder, you perform the following steps:

1. In the Datasource panel, specify which tables to include in your query and the 
columns to query from those tables.

2. Specify comparisons and other query properties such as sort order or summary 
calculations, as necessary.

3. Execute the query.

4. Use the Data Editor to insert, update, and delete database rows.
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3.8 About Schema Builder
Schema Builder is a graphical tool that enables you to create, copy, modify, and 
remove database objects and their relationships.

3.8.1 Major concepts
A schema is a collection of logical database objects, such as tables, views, indexes, 
and relationships, defined according to your needs. Schema Builder provides a way 
for you to view any combination of objects in your database, so you only need to 
see the objects you currently want to work with. Typically, the database objects you 
include in Schema Builder are those on which you expect to perform operations 
such as copying, modifying, and deleting.

Because the schema is a logical construct designed for convenience, you won’t 
create or save the schema itself. Instead, you use Schema Builder to set up a series of 
SQL operations within your schema. A commit executes those operations in the 
database.

The Schema Builder interface is designed to look very much like the Query window 
in Query Builder. Rather than manipulating queries on existing tables, however, 
Schema Builder lets you perform SQL Data Definition Language operations. You 
can edit your data dictionaries and redefine database objects in an environment that 
lets you visualize your changes before you commit them to the database.

Note: Because Schema Builder enables you to change or delete vital tables, you 
cannot access it unless you have the proper database privileges. Check with your 
System Administrator.

3.8.2 Process
To create a schema using Schema Builder, you perform the following steps:

1. Create a new schema.

2. Select data tables for your schema.

3. Create and activate relationships.

3.9 About Translation Builder
Oracle Translation Builder supports and manages translations of text extracted from 
both Oracle resource files, such as Oracle Developer applications, and non-Oracle 
resource files, such as Microsoft Windows (.rc) and HTML files.
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3.9.1 Major concepts
Translation Builder organizes projects and glossaries, manages base and translation 
modules in multiple versions, and enables reuse of earlier translations.

When you need to perform a translation, Translation Builder extracts the strings to 
be translated from resource files and imports them to the translation repository. The 
Project Navigator manages the overall process and ensures integrity of the data. 
From the Project Navigator, you can launch the Editor, which you use to translate 
the given set of strings and add the translations into the repository. Once translation 
is complete, the strings are extracted from the repository and exported to the 
resource files. If the resource type supports multiple languages, the translations are 
added back to the original resource. Otherwise, a copy of the resource is created 
with the base strings replaced by the translations.

One of the key features of Translation Builder is that previous translations are 
stored in the translation repository. The set of previous translations and glossaries is 
collectively known as Translation Memory. Upgrades and changes to an application 
do not require that the translation process be restarted from the beginning. Each 
new translation adds to the Translation Memory, making future translations easier 
and quicker to accomplish. Version control of loaded text and translations is also 
provided by the Translation Memory.

Modules can be translated from any language to any other language. Once a given 
translation is complete, that translation can be used as a base for further 
translations. For example, if an English module needs to be translated to both 
Traditional and Simplified Chinese, you can translate first to Traditional Chinese, 
and then translate the Traditional Chinese to Simplified Chinese, rather than 
returning to English. This can make translations quicker and less expensive.

Translation Builder can be operated in both client-server and stand-alone 
configurations, and the translations themselves are portable across multiple 
platforms.

3.9.2 Process
To translate a resource using Translation Builder, you perform the following steps:

1. Extract translatable strings from Oracle or non-Oracle resources and import 
them into the Translation Repository.

2. Add a translation by indicating the language(s) to which a given module will be 
translated.

3. Use the Translation Editor to execute the translation.
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4. Preview the translation by performing appearance checking and tuning to 
preserve an acceptable look and feel.

5. Extract the translated strings from the repository and merge them back into the 
original resource or into copy of the original by using the export utility.

3.10 About Oracle Developer Documentation
Oracle Developer includes a comprehensive online help system that provides 
information on a variety of conceptual, reference, and instructional topics.

■ To review the Quick Tours for a brief overview of each Oracle Developer 
component:

Choose Help→Quick Tour.

■ To step through the Cue Cards to learn how to perform common tasks:

Choose Help→Cue Cards.

■ To access the online manuals for detailed product information:

Choose Help→Manuals.

■ To locate help topics:

For the table of contents and index for online help, choose Help→Help Topics.

For context-sensitive help, press [Help] (the F1 key on most platforms).

For Form Builder key commands, choose Help→Keyboard Help, or press 
[Show Keys] (control-K on most platforms).
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A

Reports Express Integration

This section contains information that will enable you to integrate Oracle Express 
with Report Builder. It includes the following sections:

■ System Configuration

■ Buffer Size for Express Data

■ Character Set for Express Data

■ Number Ranges for Express Data

A.1 System Configuration
To create reports that use Express data, you need to configure your system as 
follows:

■ On the client, install the Reports Express Support component and the Oracle 
Express Connection Editor.

■ On the server, install an Oracle8 Server with the necessary PL/SQL packages.
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A.1.1 System Requirements
Following are the system requirements for creating reports that use Express data:

■ Windows 95 or NT

Notes: 1. It is strongly recommended that you use only 
databases that have been configured with 
Express Administrator with Reports. 
Information on configuring databases with 
Express Administrator is found in the Oracle 
Express Database Administration Guide.

2. You cannot access a .DB file that requires a 
password from Report Builder.

3. Personal Express is not supported by Report 
Builder in this release.

 Configuring Reports for Oracle Express

Desktop Client Oracle8 Oracle Express Server

S N A P I  a c c e s s  p r o v i d e r

Reports

XRU
(XRQ UI)

SNAPI SNAPI

XRB.DLL

XRB.SQL

Express Server
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■ Express Server Release 6.2 or later

■ Oracle8 Release 8.0.5 or later

■ Reports Release 6.0 or later

For individual product requirements, refer to the Express, Oracle8, or Reports 
installation information for your platform.

A.1.2 Client Side Configuration
To configure the client:

1. Insert the CD that contains the Reports product. If your CD-ROM drive 
supports the autorun feature, the Oracle Installer will start automatically. 
Otherwise, perform the following steps:

a. Shut down any active Windows applications. 

b. Open the Run dialog box from the Start menu. 

c. In the Run dialog, type the following (where D: is your CD-ROM drive 
letter): 

D:\SETUP.EXE

d. Click OK to start the Oracle Installer. 

2. When you reach the Installation Options dialog box, choose Custom 
Installation or Removal and click OK.

3. From the Available Products list, select Reports Express Support and Oracle 
Express Connection Editor from the list. Press the control key while clicking to 
make multiple selections.

4. Click Install.

Note: The Oracle Express Connection Editor is used to define connections to the 
Express Server. You only need to use the Connection Editor if your connections to 
the Express Server are not already defined for you. From Report Builder, you can 
see a list of available Express connections by choosing File→Express→Connect.

A.1.3 Server Side Configuration
There are four tasks involved in server side configuration: 

1.      Install Oracle8 Server Release 8.0.5.

2.      Install Express External Oracle8 Procedures.
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3.      Create an Express Support administrator account on Oracle8 server.

4.      Prepare user accounts with Expres Support schema objects.

A.1.3.1 Installing Oracle8 Server Release 8.0.5
See the Oracle8 installation guide for your platform.

A.1.3.2 Installing Express External Oracle8 Procedures
1. Insert the CD that contains the Report Builder product. If your CD-ROM drive 

supports the autorun feature, the Oracle Installer will start automatically. 
Otherwise, perform the following steps:

a. Shut down any active Windows applications.

b. Open the Run dialog box from the Start menu.

c. In the Run dialog, type the following (where D: is your CD-ROM drive 
letter):

 D:\SETUP.EXE

d.   Click OK to start the Oracle Installer.

2. When you reach the Installation Options dialog box, choose Custom 
Installation or Removal and click OK.

3. From the Available Products list, click the plus sign to expand the Reports 
Express Support node and choose Express External Oracle8 Procedures from 
the list.

4. Click Install.

A.1.3.3 Creating an Express Support administrator account on Oracle8 server
Only one Express Support administrator account is required per database instance.  
If the account and the required schema objects already exist, you can skip this step 
and go to Section A.1.3.4, "Preparing user accounts with Express Support schema 
objects".

1. Log into SQL*Plus as the SYSTEM user and grant the administrator account 
CREATE LIBRARY, CREATE PUBLIC SYNONYM, and CREATE SEQUENCE         
privileges. For example, if the administrator was named expadmin, the 
following commands would set up the necessary privileges:

SQL> grant connect,resource to exadmin identified by expadmin; 
SQL> grant create library, create public synonym, create sequence to 
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expadmin;

2. Log into SQL*Plus as the administrator (e.g., expadmin) and run the SQL script 
that installs the administrator schema objects:

SQL> @ %ORACLE_HOME%\olap\xrb60\xrb_admin.sql;

A.1.3.4 Preparing user accounts with Express Support schema objects
You must create Express Support schema objects for any schema that uses Express 
Support.  Using existing Express Support schema objects from another schema is 
not supported.

Note:  If you do not have a user account, you must create one before proceeding 
with this step.

1. Log into SQL*Plus as the SYSTEM user and grant the user account CREATE 
TYPE and CREATE PROCEDURE privileges. For example, if the user was        
named expuser, the following commands would set up the necessary 
privileges:

 SQL> grant create type, create procedure to expuser;

2. Log into SQL*Plus as the user (e.g., expuser) and run the SQL script that 
installs the Express Support schema objects:

 SQL> @ %ORACLE_HOME%\olap\xrb60\xrb_user.sql;

A.2 Buffer Size for Express Data
When a user creates a report that contains Express data, that data must be fetched 
from Express and stored in a memory buffer before it is displayed. The default 
buffer size is generally sufficient for most circumstances, and you can probably 
accept the default size of the buffer and not worry about making any changes.

You can specify a larger or smaller size for the buffer than the default value 
specifies.  For example, if users generate many small reports, you might want to 
reduce the buffer size.  If users generate very large reports, you might need to 
increase the size.

You change the default size of the buffer in the xrb.ini file.  Keep in mind that 
this file resides on the Oracle8 server and is shared by many users.  The server 
allocates the same size buffer to all users of that server for the duration of the time 
that data is being fetched from Express.  Use care when specifying the size to fit the 
needs of the many users who are concurrently accessing Express data.  The size 
Reports Express Integration A-5



Buffer Size for Express Data
should be large enough to allow users to fetch the data for their reports while 
ensuring that the server has sufficient memory.

A.2.1 Buffer sizes
The following list describes some of the buffer sizes:

■ 64kb: This is the minimum buffer size that is allowed.  Even if you specify a 
smaller size, the buffer will have a size of 64kb.

■ 2MB: This is the default buffer size.  If you do not specify a different size, the 
buffer will have a size of 2MB.

■ 50MB: This is the maximum buffer size that is allowed.  Even if you specify a 
larger size, the buffer will have a size of 50MB.  You must ensure that the 
Oracle8 server has a very large amount of memory before specifying such a 
large buffer size. 

A.2.2 Specifying the buffer size
To specify the buffer size, you must create or modify the xrb.ini file so that the 
setting can take effect.  The following procedure explains how to make the 
specification in the file.

1. On the computer on which Oracle8 is running, look in the 
%ORACLE_HOME%/BIN directory for a file called xrb.ini.  If the file exists, 
proceed to Step 3.  Otherwise, proceed to Step 2.

2. With a text editor, create a file called xrb.ini in the %ORACLE_HOME%/BIN 
directory.

3. In a text editor, scroll to the [Options] section of the file, or create this section 
label if it does not exist.

4. Edit the value of the FetchAlloc setting if it exists; otherwise, create the 
setting.  Enter an integer value specifying the number of bytes, such as 100000 
or 6000000.

5. Save your changes and close the file.

A.2.3 Example setting for a buffer size
The following example shows a sample setting of 4MB for the buffer size.

[Options]
FetchAlloc = 4000000
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A.3 Character Set for Express Data
If you have changed the default single-byte character set in Express, you must 
create or modify a file for Oracle Reports so that Reports will handle data from the 
Express database appropriately. The file is called XRB.INI and you use it to specify 
information about the character set that the database is using.  The following 
procedure explains how to make the specification in the file.

1. On the computer on which Oracle8 is running, look in the 
%ORACLE_HOME%/bin directory for a file called XRB.INI. If the file exists, 
proceed to Step 3. Otherwise, proceed to Step 2.

2. With a text editor, create a file called XRB.INI in the %ORACLE_HOME%/bin 
directory.

3. In a text editor, scroll to the [XPCharSet] section of the file, or create this 
section label if it does not exist.

4. Edit the value of the XPCharSet setting if it exists; otherwise, create the setting. 
Use the following format for the value of the setting:

language_territory.charset

where language, territory, and charset are values obtained from the 
following tables.

5. Save your changes and close the file.

The following example shows a sample setting for the character set:

[XPCharSet]
XPCharSet = AMERICAN_AMERICA.US8PC437

A.3.1 Languages
The following table lists the values to enter for language in the XPCharSet setting. If 
the value has multiple words, include a space between each word, as shown in the 
following example.

[XPCharSet]
XPCharSet = BRAZILIAN PORTUGUESE_BRAZIL.WE8PC850
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A.3.2 Territories
The following table lists the values to enter for territory in the XPCharSet setting.

Language

AMERICAN ARABIC BENGALI

BRAZILIAN PORTUGUESE BULGARIAN CANADIAN FRENCH

CATALAN CROATIAN CZECH

DANISH DUTCH EGYPTIAN

ENGLISH ESTONIAN FINNISH

FRENCH GERMAN DIN GERMAN

GREEK HEBREW HUNGARIAN

ICELANDIC ITALIAN JAPANESE

KOREAN LATIN AMERICAN SPANISH LATVIAN

LITHUANIAN MALAY MEXICAN SPANISH

NORWEGIAN POLISH PORTUGESE

ROMANIAN RUSSIAN SIMPLIFIED CHINESE

SLOVAK SLOVENIAN SPANISH

SWEDISH THAI TRADITIONAL CHINESE

TURKISH UKRAINIAN VIETNAMESE

Territory

ALGERIA AMERICA AUSTRIA

BAHRAIN BANGLADESH BRAZIL

BULGARIA CANADA CATALONIA

CHINA CIS CROATIA

CZECH REPUBLIC CZECHOSLOVAKIA DENMARK

DJIBOUTI EGYPT ESTONIA

FINLAND FRANCE GERMANY

GREECE HONG KONG HUNGARY
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A.3.3 Storage Character Sets
The following table lists the values to enter for charset in the XPCharSet setting. The 
value is specified in the Name column.

ICELAND IRAQ ISRAEL

ITALY JAPAN JORDAN

KOREA KUWAIT LATVIA

LEBANON LIBYA LITHUANIA

MALAYSIA MAURITANIA MEXICO

MOROCCO NORWAY OMAN

POLAND PORTUGAL QATAR

ROMANIA SAUDI ARABIA SLOVAKIA

SLOVENIA SOMALIA SPAIN

SUDAN SWEDEN SWITZERLAND

SYRIA TAIWAN THAILAND

THE NETHERLANDS TUNISIA TURKEY

UKRAINE UNITED ARAB EMIRATES UNITED KINGDOM

VIETNAM YEMEN

ID Name Description

1 US7ASCII ASCII 7-bit American

2 WE8DEC DEC 8-bit West European

3 WE8HP HP LaserJet 8-bit West European

4 US8PC437 IBM-PC Code Page 437 8-bit American

5 WE8EBCDIC37 EDCDIC Code Page 37 8-bit West European

6 WE8EBCDIC500 EDCDIC Code Page 500 8-bit West European

8 WE8EBCDIC285 EDCDIC Code Page 285 8-bit West European

Territory
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10 WE8PC850 IBM-PC Code Page 850 8-bit West European

11 D7DEC DEC VT100 7-bit German

12 F7DEC DEC VT100 7-bit French

13 S7DEC DEC VT100 7-bit Swedish

14 E7DEC DEC VT100 7-bit Spanish

15 SF7ASCII ASCII 7-bit Finnish

16 NDK7DEC DEC VT100 7-bit Norwegian/Danish

17 I7DEC DEC VT100 7-bit Italian

18 NL7DEC DEC VT100 7-bit Dutch

19 CH7DEC DEC VT100 7-bit Swiss (German/French)

20 YUG7ASCII ASCII 7-bit Yugoslavian

21 SF7DEC DEC VT100 7-bit Finnish

22 TR7DEC DEC VT100 7-bit Turkish

23 IW7IS960 Israeli Standard 960 7-bit Latin/Hebrew

25 IN8ISCII Multiple-Script Indian Standard 8-bit Latin/Indian 
Languages

31 WE8IS08859P1 ISO 8859-1 West European

32 EE8ISO8859P2 ISO 8859-2 East European

33 SE8ISO8859P3 ISO 8859-3 South European

34 NEE8ISO8859P4 ISO 8859-4 North and North-East European

35 CL8ISO8859P5 ISO 8859-5 Latin/Cyrillic

36 AR8ISO8859P6 ISO 8859-6 Latin/Arabic

37 EL8ISO8859P7 ISO 8859-7 Latin/Greek

38 IW8ISO8859P8 ISO 8859-8 Latin/Hebrew

39 WE8ISO8859P9 ISO 8859-9 West European & Turkish

40 NE8ISO8859P10 ISO 8859-10 North European

41 TH8TISASCII Thai Industrial Standard 620-2533 - ASCII 8-bit

42 TH8TISEBCDIC Thai Industrial Standard 620-2533 - EBCDIC 8-bit

ID Name Description
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43 BN8BSCII Bangladesh National Code 8-bit BSCII

44 VN8VN3 VN3 8-bit Vietnamese

50 WE8NEXTSTEP NeXTSTEP PostScript 8-bit West European

70 AR8EBCDICX EBCDIC XBASIC Server 8-bit Latin/Arabic

81 EL8DEC DEC 8-bit Latin/Greek

82 TR8DEC DEC 8-bit Turkish

90 WE8EBCDIC37C EBCDIC Code Page 37 8-bit Oracle/c

91 WE8EBCDIC500C EBCDIC Code Page 500 8-bit Oracle/c

92 IW8EBCDIC424 EBCDIC Code Page 424 8-bit Latin/Hebrew

93 TR8EBCDIC1026 EBCDIC Code Page 1026 8-bit Turkish

94 WE8EBCDIC871 EBCDIC Code Page 871 8-bit Icelandic

95 WE8EBCDIC284 EBCDIC Code Page 284 8-bit Latin American/Spanish

110 EEC8EUROASCI EEC Targon 35 ASCI West European/Greek

113 EEC8EUROPA3 EEC EUROPA3 8-bit West European/Greek

114 LA8PASSPORT German Government Printer 8-bit All-European Latin

140 BG8PC437S IBM PC Code Page 437 8-bit (Bulgarian Modification)

150 EE8PC852 IBM PC Code Page 852 8-bit East European

152 RU8PC866 IBM PC Code Page 866 8-bit Latin/Cyrillic

153 RU8BESTA BESTA 8-bit Latin/Cyrillic

154 IW8PC1507 IBM PC Code Page 1507/862 8-bit Latin/Hebrew

155 RU8PC855 IBM PC Code Page 855 8-bit Latin/Cyrillic

156 TR8PC857 IBM PC Code Page 857 8-bit Turkish

158 CL8MACCYRILLIC Mac Client 8-bit Latin/Cyrillic

159 CL8MACCYRILLICS Mac Server 8-bit Latin/Cyrillic

160 WE8PC860 IBM PC Code Page 860 8-bit West European

161 IS8PC861 IBM PC Code Page 861 8-bit Icelandic

162 EE8MACCES Mac Server 8-bit Central European

163 EE8MACCROATIANS Mac Server 8-bit Croatian

ID Name Description
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164 TR8MACTURKISHS Mac Server 8-bit Turkish

165 IS8MACICELANDICS Mac Server 8-bit Icelandic

166 EL8MACGREEKS Mac Server 8-bit Greek

167 IW8MACHEBREWS Mac Server 8-bit Hebrew

170 EE8MSWIN1250 MS Windows Code Page 1250 8-bit East European

171 CL8MSWIN1251 MS Windows Code Page 1251 8-bit Latin/Cyrillic

172 ET8MSWIN923 MS Windows Code Page 923 8-bit Estonian

173 BG8MSWIN MS Windows 8-bit Bulgarian Cyrillic

174 EL8MSWIN1253 MS Windows Code Page 1253 8-bit Latin/Greek

175 IW8MSWIN1255 MS Windows Code Page 1255 8-bit Latin/Hebrew

176 LT8MSWIN921 MS Windows Code Page 921 8-bit Lithuanian

177 TR8MSWIN1254 MS Windows Code Page 1254 8-bit Turkish

178 WE8MSWIN1252 MS Windows Code Page 1252 8-bit West European

179 BLT8MSWIN1257 MS Windows Code Page 1257 8-bit Baltic

180 D8EBCDIC273 EBCDIC Code Page 273/1 8-bit Austrian German

181 I8EBCDIC280 EBCDIC Code Page 280/1 8-bit Italian

182 DK8EBCDIC277 EBCDIC Code Page 277/1 8-bit Danish

183 S8EBCDIC278 EBCDIC Code Page 278/1 8-bit Swedish

184 EE8EBCDIC870 EBCDIC Code Page 870 8-bit East European

185 CL8EBCDIC1025 EBCDIC Code Page 1025 8-bit Cyrillic

186 F8EBCDIC297 EBCDIC Code Page 297 8-bit French

187 IW8EBCDIC1086 EBCDIC Code Page 1086 8-bit Hebrew

188 CL8EBCDIC1025X EBCDIC Code Page 1025 (Modified) 8-bit Cyrillic

190 N8PC865 IBM-PC Code Page 865 8-bit Norwegian

191 BLT8CP921 Latvian Standard LVS8-92(1) Windows/Unix 8-bit Baltic

192 LV8PC1117 IBM-PC Code Page 1117 8-bit Latvian

193 LV8PC8LR Latvian Version IBM-PC Code Page 866 8-bit 
Latin/Cyrillic
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194 BLT8EBCDIC1112 EBCDIC Code Page 1112 8-bit Baltic Multilingual

195 LV8RST104090 IBM-PC Alternative Code Page 8-bit Latvian 
(Latin/Cyrillic)

196 CL8KOI8R RELCOM Internet Standard 8-bit Latin/Cyrillic

197 BLT8PC775 IBM-PC code Page 775 8-bit Baltic

201 F7SIEMENS9780X Siemens 97801/97808 7-bit French

202 E7SIEMENS9780X Siemens 97801/97808 7-bit Spanish

203 S7SIEMENS9780X Siemens 97801/97808 7-bit Swedish

204 DK7SIEMENS9780X Siemens 97801/97808 7-bit Danish

205 N7SIEMENS9780X Siemens 97801/97808 7-bit Norwegian

206 I7SIEMENS9780X Siemens 97801/97808 7-bit Italian

207 D7SIEMENS9780X Siemens 97801/97808 7-bit German

210 WE8GCOS7 Bull EBCDIC GCOS7 8-bit West European

211 EL8GCOS7 Bull EBCDIC GCOS7 8-bit Greek

221 US8BS2000 Siemens 9750-62 EBCDIC 8-bit American

222 D8BS2000 Siemens 9750-62 EBCDIC 8-bit German

223 F8BS2000 Siemens 9750-62 EBCDIC 8-bit French

224 E8BS2000 Siemens 9750-62 EBCDIC 8-bit Spanish

225 DK8BS2000 Siemens 9750-62 EBCDIC 8-bit Danish

231 WE8BS2000 Siemens EBCDIC.DF.04 8-bit West European

235 CL8BS2000 Siemens EBCDIC.EHC.LC 8-bit Cyrillic

239 WE8BS2000L5 Siemens EBCDIC.DF.04.L5 8-bit West European/Turkish

241 WE8DG DG 8-bit West European

251 WE8NCR4970 NCR 4970 8-bit West European

261 WE8ROMAN8 HP Roman8 8-bit West European

262 EE8MACCE Mac Client 8-bit Central European

263 EE8MACCROATIAN Mac Client 8-bit Croatian

264 TR8MACTURKISH Mac Client 8-bit Turkish
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265 IS8MACICELANDIC Mac Client 8-bit Icelandic

266 EL8MACGREEK Mac Client 8-bit Greek

267 IW8MACHEBREW Mac Client 8-bit Hebrew

277 US8ICL ICL EBCDIC 8-bit American

278 WE8ICL ICL EBCDIC 8-bit West European

279 WE8ISOICLUK ICL special version ISO8859-1

351 WE8MACROMAN8 Mac Client 8-bit Extended Roman8 West European

352 WE8MACROMAN8S Mac Server 8-bit Extended Roman8 West European

353 TH8MACTHAI Mac Client 8-bit Latin/Thai

354 TH8MACTHAIS Mac Server 8-bit Latin/Thai

368 HU8CWI2 Hungarian 8-bit CWI-2

380 EL8PC437S IBM-PC Code Page 437 8-bit (Greek modification)

381 EL8EBCDIC875 EBCDIC Code Page 875 8-bit Greek

382 EL8PC737 IBM-PC Code Page 737 8-bit Greek/Latin

383 LT8PC772 IBM-PC Code Page 772 8-bit Lithuanian (Latin/Cyrillic)

384 LT8PC774 IBM-PC Code Page 774 8-bit Lithuanian (Latin)

385 EL8PC869 IBM-PC Code Page 869 8-bit Greek/Latin

386 EL8PC851 IBM-PC Code Page 851 8-bit Greek/Latin

390 CDN8PC863 IBM-PC Code Page 863 8-bit Canadian French

401 HU8ABMOD Hungarian 8-bit Special AB Mod

500 AR8ASMO8X ASMO Extended 708 8-bit Latin/Arabic

554 AR8NAFITHA711 Nafitha Enhanced 711 Server 8-bit Latin/Arabic

555 AR8SAKHR707 SAKHR 707 Server 8-bit Latin/Arabic

556 AR8MUSSAD768 Mussa’d Alarabi/2 768 Server 8-bit Latin/Arabic

557 AR8ADOS710 Arabic MS-DOS 710 Server 8-bit Latin/Arabic

558 AR8ADOS720 Arabic MS-DOS 720 Server 8-bit Latin/Arabic

559 AR8APTEC715 APTEC 715 Server 8-bit Latin/Arabic

560 AR8MSAWIN MS Windows Code Page 1256 8-Bit Latin/Arabic
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560 AR8MSWIN1256 MS Windows Code Page 1256 8-Bit Latin/Arabic

561 AR8NAFITHA721 Nafitha International 721 Server 8-bit Latin/Arabic

563 AR8SAKHR706 SAKHR 706 Server 8-bit Latin/Arabic

565 AR8ARABICMAC Mac Client 8-bit Latin/Arabic

566 AR8ARABICMACS Mac Server 8-bit Latin/Arabic

590 LA8ISO6937 ISO 6937 8-bit Coded Character Set for Text 
Communication

797 US8NOOP No-op character set prohibiting conversions

829 JA16VMS JVMS 16-bit Japanese

830 JA16EUC EUC 16-bit Japanese

832 JA16SJIS Shift-JIS 16-bit Japanese

833 JA16DBCS IBM DBCS 16-bit Japanese

835 JA16EBCDIC930 IBM DBCS Code Page 290 16-bit Japanese

836 JA16MACSJIS Mac client Shift-JIS 16-bit Japanese

840 KO16KSC5601 KSC5601 16-bit Korean

842 KO16DBCS IBM DBCS 16-bit Korean

845 KO16KSCCS KSCCS 16-bit Korean

850 ZHS16CGB231280 CGB2313-80 16-bit Simplified Chinese

851 ZHS16MACCGB231280 Mac client CGB2313-80 16-bit Simplified Chinese

860 ZHT32EUC EUC 32-bit Traditional Chinese

861 ZHT32SOPS SOPS 32-bit Traditional Chinese

862 ZHT16DBT Taiwan Taxation 16-bit Traditional Chinese

863 ZHT32TRIS TRIS 32-bit Traditional Chinese

864 ZHT16DBCS IBM DBCS 16-bit Traditional Chinese

865 ZHT16BIG5 BIG5 16-bit Traditional Chinese

866 ZHT16CCDC HP CCDC 16-bit Traditional Chinese
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A.4 Number Ranges for Express Data
The following sections describe the acceptable ranges for numbers in Express data.

A.4.1 Very large positive or negative numbers
Express can store extremely large positive or negative numbers. In most cases, these 
numbers can easily be displayed in Reports. However, if the number is outside of a 
certain range, it cannot be displayed in Reports. An "out of range data error" 
message is displayed if an Express decimal number x is found in the following 
range:

x > 9.9999999999999999999999999999999999999 * 10125

x < -9.9999999999999999999999999999999999999 * 10125

A.4.2 Rounding very small numbers
Express can store extremely small decimal numbers, such as numbers less than zero 
with several hundred decimal places. In most cases, these numbers can easily be 
displayed in reports. You can use a setting to specify whether numbers outside of 
certain ranges are rounded up to zero and displayed as zero in reports or whether a 
"rounding data error" message is displayed. The setting affects an Express decimal 
number x in the following ranges:

-1 * 10-125 < x <= -4.94065645841246544 * 10-324

4.94065645841246544 * 10-324 <= x < 1 * 10-125

A.4.3 Specifying the rounding setting
To specify the setting for rounding, you must create or modify the xrb.ini file, so 
that the setting can take effect. The following procedure explains how to make the 
specification in the file.

870 AL24UTFFSS Unicode UTF-8

997 JA16TSTSET2 ASCII-based 16-bit Test Character Set

998 JA16TSTSET Shift-sensitive ASCII-based Test Character Set

ID Name Description
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1. On the computer on which Oracle8 is running, look in the 
%ORACLE_HOME%/BIN directory for a file called xrb.ini. If the file exists, 
proceed to Step 3. Otherwise, proceed to Step 2.

2. With a text editor, create a file called xrb.ini in the %ORACLE_HOME%/BIN 
directory.

3. In a text editor, scroll to the [Options] section of the file, or create this section 
label if it does not exist.

4. Edit the value of the ZeroSmallNumbers setting if it exists; otherwise, create 
the setting. Specify one of the following values:

5. Save your changes and close the file.

A.4.4 Example setting for rounding
The following example shows a sample setting for the rounding setting.

[Options]
ZeroSmallNumbers = 0

Value Description

0 Display an error message rather than displaying very 
small numbers in reports.

1 Round very small numbers up to zero and display them 
in reports. (This is the default setting.)
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